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CAPSENSE™ Tuner version 8.0.0

About this document
Scope and purpose

The CAPSENSE™ Tuner is used to tune CAPSENSE™ applications.
A newer revision of this document may be available on the web here.
Intended audience

This document helps application developers understand how to use the CAPSENSE™ Tuner as part of creating a
ModusToolbox™ application.
 
Document conventions

Convention Explanation
Bold Emphasizes heading levels, column headings, menus and sub-menus

Italics Denotes file names and paths.

Monospace Denotes APIs, functions, interrupt handlers, events, data types, error handlers, file/folder
names, directories, command line inputs, code snippets

File > New Indicates that a cascading sub-menu opens when you select a menu item
 
Abbreviations and definitions

The following define the abbreviations and terms used in this document:
• Application – One or more projects related to each other.
• CAPSENSE – capacitive sensing
• Configurator – A GUI-based tool used to configure a resource.
• CSD – self-capacitance sensing method
• CSX – CAPSENSE™ Transmit/Receive (CAPSENSE™ with two electrodes: Tx and Rx), mutual capacitance

sensing method
• ISX – inductive sensing method
• IDE – integrated development environment
• CSD HW – CAPSENSE™ Sigma Delta – 4th generation hardware (HW) block
• MSC HW – multi-sensing converter – 5th generation hardware (HW) block
• MSCLP HW – multi-sensing converter low power – 5th generation LP hardware (HW) block
• Peripheral – Any external analog or digital device that provides an input and output for the computer.
• PSOC™ – programmable system-on-chip
• RTT – real-time transfer
• SMARTSENSE – Auto-tuning process used for proper functionality and optimized performance of the

CAPSENSE™ system.
• SNR – signal-to-noise ratio
• Widget – A CAPSENSE™ functional unit consisting of one sensor or a group of similar sensors, implementing

a specific higher-level functionality such as Button, Proximity Sensor, Linear Slider, Radial Slider, Matrix
Buttons, Touchpad, Low Power, and Liquid Level widget.
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Reference documents

Refer to the following documents for more information as needed:
• ModusToolbox™ tools package user guide
• Eclipse IDE for ModusToolbox™ user guide
• VS Code for ModusToolbox™ user guide
• CAPSENSE™ Configurator user guide
• Device Configurator user guide
• MTB CAT1 Peripheral driver library
• MTB CAT2 Peripheral driver library
• Device datasheets
• Device technical reference manuals
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1 Overview
The CAPSENSE™ Tuner is a stand-alone tool included with the ModusToolbox™ software. The tool is used to tune
CAPSENSE™ applications.
Prior to using the CAPSENSE™ Tuner, create a CAPSENSE™ application and program it into the device. Refer to
the CAPSENSE ™ Configurator user guide and CAPSENSE ™ middleware documentation for help. Your
application must contain the CAPSENSE™ Middleware and a communication interface (I2C, UART or RTT). The
Tuner works with the KitProg3, MiniProg4, and UART devices.
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2 Launch the CAPSENSE™ Tuner
There are several ways to launch the CAPSENSE™ Tuner, and those ways depend on how you use the various
tools in ModusToolbox™. However, the easiest way is to launch it using the Device Configurator because the
CAPSENSE™ Tuner requires a properly configured CAPSENSE™ application programmed into the device. Refer to
the Device Configurator user guide for more details.

2.1 From the Device Configurator
You can launch the CAPSENSE™ Tuner from the Device Configurator. Refer to the Device Configurator user guide
for more details.
The process differs slightly depending on the hardware block:
• The 4th generation CAPSENSE™ – one CSD resource.
• The 5th generation CAPSENSE™ – two and more MSC resources.
• The 5th generation LP CAPSENSE™ – one MSCLP resource.
 
1. On the Peripherals tab, select the CSD (CapSense) resource or the CapSense and one or more MSC or

MSCLP resources, as applicable for your device.

2. (Skip this step for MSCLP.) On the Parameters pane, select an appropriate input Clock.

3. For the MSC and MSCLP HW blocks, select the CapSense resource category on the Peripherals tab.

4. On the Parameters pane, click the Launch CAPSENSE™ Tuner button.
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2.2 make command
As described in the ModusToolbox ™ tools package user guide ModusToolbox build system chapter, you can run
numerous make commands in the application directory, such as launching the CAPSENSE™ Tuner. After you
have created a ModusToolbox™ application, navigate to the application directory and type the following
command in the appropriate bash terminal window:

make capsense-tuner

This command opens the CAPSENSE™ Tuner GUI for the specific application in which you are working.

2.3 VS Code and Eclipse
VS Code and Eclipse have tools to launch the CAPSENSE™ Tuner Configurator from within an open application.
Refer to the applicable user guide for more details:
• VS Code for ModusToolbox™ user guide
• Eclipse IDE for ModusToolbox™ user guide

2.4 Executable (GUI)
You can launch the CAPSENSE™ Tuner GUI by running its executable as appropriate for your operating system.
By default, the CAPSENSE™ Tuner is installed here:
<install_dir>/ModusToolbox//tools_<version>/capsense-configurator
When run independently, the application opens without any information. You need to open a specific
CAPSENSE™ application configuration file that was created by the CAPSENSE™ Configurator for the Tuner to
work. See Menus under GUI description for more information about opening a configuration file.

2.5 From the Command Line
You can run the Tuner from the command line. However, there are few reasons to do this in practice.
For information about the command-line options, run the Tuner using the -h option.
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3 Quick start
This section provides a simple workflow for how to use the CAPSENSE™ Tuner.
1. Create a CAPSENSE™ application with a Tuner communication interface and program the application

into the device. Refer to the Eclipse IDE for ModusToolbox ™ user guide and the CAPSENSE™ Configurator
user guide for more details.

Note: The simplest way to start with CAPSENSE™ Tuner is to use the PSOC ™ 6 CAPSENSE™ Buttons
and Slider code example configured to work on PSOC™ 6 MCU kits or PSOC™ 4 MSC CAPSENSE™

CSD Button Tuning to work on PSOC™ 4 MCU kits.

2. Launch the CAPSENSE™ Tuner.
3. Start Communication. Click Connect and select the required communication interface.

Note: Refer to the KitProg user guide for the supported configurations and modes. For this example,
I2C address, sub-address, and speed must match the configuration.

Note: For the I2C communication, the Tuner only supports the 2-Bytes Sub-address.

4. Click Start to extract data.

5. Touch the sensors on the hardware and notice the change in the sensor/widget status on Widget View
tab.

6. Open the Graph View tab. Check the sensors in the Widget Explorer Pane to observe sensor signals in the
graph. Touch the sensors and notice the signal change on the Graph View tab.

7. Change widget/sensor parameter values as needed. Then, apply the new settings to the device using the
Apply to Device command.
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8. Save the Tuner parameters. Click the Apply to Project command.
9. Exit the Tuner application.
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4 GUI description
The CAPSENSE™ Tuner application contains Menus, Main toolbar, and Tabs toolbars, Widget Explorer pane and
Widget/Sensor Parameters pane, all used to tune a CAPSENSE™ application.
Menus
File
• Open – Opens a <file_name>.cycapsense configuration file. This command is visible only when running the

Tuner independently from the Eclipse IDE.
• Apply to Device – Commits changed values of a widget/sensor parameter to the device. This command

becomes active if a value of any configuration parameter from the Tuner application changes (that is, if the
parameter values in the Tuner and the device are different). This is an indication to apply the changed
parameter values to the device. For Read Only mode of the communication interfaces, this command is
grayed out.

• Open is System Explorer – This opens your computer’s file explorer tool to the folder that contains the
*.cycapsense file.

• Import... – Imports a specified configuration file.
• Export... – Exports the current configuration file into a specified file.
• Export Register Map to PDF – Exports the current configuration register map in PDF format for the latest

version of the middleware available on the date of the CAPSENSE™ Tuner release.
• Recent files – Shows recent files that you can open directly.
• Exit – Asks to save changes if there are any and closes the Tuner. Changes are saved to the configuration

file.
Edit
• Undo – Undoes the last action or sequence of actions.
• Redo – Redoes the last undone action or sequence of undone actions.
View
• Widget Explorer – Hides or shows the Widget Explorer pane where widgets and sensors tree display.
• Notice List – Hides or shows the Notice List pane. The pane is shown by default.
• Widget/Sensor Parameters – Hides or shows the Widget/Sensor Parameters pane.
• Gesture Event History – Logs the detected gestures information. Displays in the View when any gesture is

available.
• Gesture Monitor – Provides visual indication for a detected gesture. Displays in the View when any gesture

is available.
• OpenOCD Log – Hides or shows the OpenOCD Log pane.
• Toolbar – Hides or shows the Toolbar. Enabled by default.
• Reset View – Resets the view to the default.
Communication
• Connect – Connects to the device via a communication channel selected in the Tuner Communication

Setup dialog. If the channel was not previously selected, the Tuner Communication dialog is shown.
• Disconnect – Closes the communication channel with the connected device.
• Start – Starts reading data from the device.
• Stop – Stops reading data from the device.
• Restart – Restarts reading data from the device.
Tools
• Tuner Communication Setup… – Opens the configuration dialog to set up a communication channel with

the device.
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• Options… – Opens the configuration dialog to set up Tuner preferences: Display, SNR, Logging,
Advanced.

• Logging – Starts/stops data logging into a specified file.
Help
• View Help – Opens the CAPSENSE™ Tuner guide (this document).
• About CAPSENSE™ Tuner – Opens the About box to display the version information, with links to open

https://www.infineon.com and the current session log file.

4.1 Main toolbar
Contains frequently used buttons that duplicate the main menu items:

•  Opens the configuration dialog to set up a communication channel with the device. The same as the
Tools > Tuner Communication Setup menu command.

•  Connects to the device via a communication channel selected in the Tuner Communication Setup
dialog. The same as the Communication > Connect menu command.

•  Closes the communication channel with the connected device. The same as the Communication >
Disconnect menu command

•  Starts reading data from the device. The same as the Communication > Start menu command.

•  Stops reading data from the device. The same as the Communication > Stop menu command.

• Restarts reading data from the device The same as the Communication > Restart menu command.

•  Opens a configuration file. The same as the File > Open menu command.

•  Commits changed values of a widget/sensor parameter to the device. The same as the File > Apply to
Device menu command.

•  Commits changed values of a widget / sensor parameter to the CAPSENSE™ project. The same as the
File > Apply to Project menu command.

•  Imports a specified configuration file. The same as the File > Import menu command.

•  Exports the current configuration file into a specified file. The same as the File >Export menu
command.

•  Starts or stops data logging into a specified file. The same as the Tools > Logging menu command.
• Read mode – Selects the Tuner communication mode with a device (I2C and UART with LP).
• Synchronized – Application firmware periodically calls a corresponding Tuner function:

Cy_CapSense_RunTuner(). The Tuner synchronizes data reading and firmware execution to preserve data
coherency. CAPSENSE™ middleware waits for the Tuner read/write operation to be completed prior to
execution of sensor scan and processing tasks. The Tuner does not read/write data until CAPSENSE™

middleware completes scanning and data processing tasks for all widgets in the application. The SNR and
noise measurements are most accurate, and most tuning parameters can be edited in real time updating in
this mode.

• Asynchronized – The Tuner reads data asynchronously with sensor scanning and data processing. Due
to this, data coherency may be corrupted. So, the Tuner may read only partially updated sensor data.
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For example, the device completed scanning of only the first sensor in a row. At this moment, the Tuner
reads data of the latest scan from the first sensor and data of previous scans from the remaining sensor.
This can occur to all sensors, when the Tuner reads data prior to the completion of data processing
tasks, such as baseline update and filter execution. SNR and noise measurements are less accurate due
to non-coherent data reading and only a limited set of tuning parameters can be edited in real time in
this mode. Asynchronized mode may work unreliably with Low Power widgets configurations when the
application is mostly in Deep Sleep. The Tuner may miss the time window when the device awakes and is
able to communicate with the Tuner.

•  Undoes the last action or sequence of actions. The same as the Edit > Undo menu command.

•  Redoes the undone action or sequence of undone actions. The same as the Edit > Redo menu
command.

4.2 Tabs toolbars
The toolbars of the CAPSENSE™ Tuner tabs have mostly the same options:

Option Description Widget
View tab

Graph
View tab

SNR
Measure
ment tab

Liquid
Level
Measure
ment tab

Touchpad
View tab

Gesture
View tab

Zoom in
Zooms in the widgets.
Press the [Esc] key to
undo zoom.

√ √     √  

Zoom out
Zooms out the widgets.
Press the [Esc] key to
undo zoom.

√ √     √  

Graph Shows or hides the
Touch Signal Graph. √          

Save image

Opens the dialog to
save the tab view as an
image. To save the
whole main window as
an image, press and
hold the [Ctrl] key. The
supported
formats: .PNG, .JPG,
BMP.

√ √ √ √ √ √

Number of
samples

Defines the total
amount of data
samples shown on a
single graph.

  √        

Legend

Shows or hides the
sensor series
descriptions (with
names and colors) in
graphs

  √ √ √    

Clear graph/
Clear

Clears all graphs. √ √ √ √ √  
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Option Description Widget
View tab

Graph
View tab

SNR
Measure
ment tab

Liquid
Level
Measure
ment tab

Touchpad
View tab

Gesture
View tab

Spike Highlights spikes on the
graph.     √      

Opaque
The level of opacity of
the area below the line
series.

  √        

Graph View tab
toolbar (Chart
settings)

Opens the menu for
editing the chart line
series parameters

  √        

Reset position

Resets the image
position and zoom. The
image is moved to the
center of the panel.

          √

Open image Opens a custom image.           √

Saved logged
data

Saves data to a .csv file,
by default to the
design.lls.csv file.

      √    

Load logged
data

Logs data to a .csv file,
by default to the
design.lls.csv file.

      √    

4.3 Widget Explorer pane
The Widget Explorer pane contains a tree of widgets and sensors used in the CAPSENSE™ application. You can
expand/collapse the Widget nodes to show/hide widget’s sensor nodes. You can check/uncheck individual
widgets and sensors in the Widget Explorer pane. The widget checked status affects its visibility in the Widget
View tab and the position graph series in the Graph View tab while the sensor checked status controls the
visibility of the sensor raw count/baseline/signal/status graph series in the Widget View tab and signals in the
Touch Signal Graph on the Widget View tab.
Selecting a widget or sensor in the Widget Explorer pane updates the selection in the Widget/Sensor
Parameters pane.

Note: For CSX widgets, the sensor tree displays individual nodes (Rx0_Tx0, Rx0_Tx1 …) contrary to the
CAPSENSE™ Configurator where the CSX electrodes are displayed (Rx0, Rx1 … Tx0, Tx1 ...).

Note: For ISX widgets, the sensor tree displays individual nodes (Rx0_Lx0, Rx0_Lx1 …) contrary to the
CAPSENSE™ Configurator where the ISX electrodes are displayed (Rx0, Rx1 … Lx0, Lx1 ...).

Note: For MSC HW configurations with enabled Multi-frequency mode, the Median check box in the Widget
Explorer for each sensor displays a set of F0 values received from a kit in the Graph View tab tab.
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4.4 Widget/Sensor Parameters pane
The Widget/Sensor Parameters pane displays the parameters of a widget or sensor selected in the Widget
Explorer tree. The grid is similar to the grid on the Widget Details tab in the CAPSENSE™ Configurator with
some exceptions. Some parameters available for modification in the CAPSENSE™ Configurator cannot be
modified in the Tuner and some other minor differences. Select a parameter to see its description on the panel
below the parameters list.
The Widget/Sensor Parameters pane includes the following groups of parameters:

Widget parameters

Widget general parameters
Cannot be modified from the CAPSENSE™ Tuner because corresponding parameter values reside in the
application flash widget structures that cannot be modified at run-time.
Widget hardware parameters
Cannot be modified for the widgets with SMARTSENSE.
All Widget hardware parameters require hardware re-initialization. In Manual tuning mode, the availability of
changing the Widget hardware parameters and Apply to Device command depends on the mode and
communication protocol.

Protocol I2C UART RTT
Mode Read/Write

Apply to Device √ √ √

Widget hardware parameters √ √ √

Mode Read only

Apply to Device √    

Widget hardware parameters   √ √
Capacitive DAC parameters
Cannot be modified for the widgets with SMARTSENSE or appropriate CDAC mode set to AUTO in the
CAPSENSE™ Configurator.
Scaled capacitive DAC parameters
This group of parameters is available only for the 5th generation LP devices. These parameters are read-only
and applicable only for the CSD sensing method. Calculated from an actual CDAC with the scaling value.
Widget threshold parameters
Cannot be modified for widgets with SMARTSENSE– Full. In Manual tuning mode (for all widgets), the
availability of changing Widget threshold parameters and Apply to Device command depends on the mode and
communication protocol.

Protocol I2C UART RTT
Mode Read/Write

Apply to Device √ √ √

Widget threshold parameters √ √ √

Mode Read only

Apply to Device √    
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Protocol I2C UART RTT
Widget threshold parameters √

Note: Except ON
debounce parameter
(requires hardware

re-initialization).

√ √

Position filter parameters, Adaptive IIR filter parameters, Ballistic multiplier parameters, and Centroid
parameters
Cannot be modified at runtime from the Tuner because, unlike the other parameters, these parameter values
reside in the application flash widget structures that cannot be modified at run-time.

Sensor Parameters

Sensing parameters
• When IDAC/CDAC is enabled, the parameter is read-only and displays values as calibrated by the firmware.
• When the auto-calibration is disabled, the IDAC/CDAC value entered in the CAPSENSE™ Configurator

displays and the parameter becomes writable in Read/Write mode.
Capacitance (fF)
When BIST is enabled in the CAPSENSE™ Configurator, the sensor/electrode capacitance is read-only, and
displays values calculated by the firmware. The application code must have BIST-related function calls. When
BIST is disabled, the Capacitance (fF) group is hidden

Note: The Position filter parameters, Adaptive IIR filter parameters, and Gesture parameters reflect
data stored in a loaded configuration file. Actual values may vary on a target device connected to the
CAPSENSE™ Tuner.

Note: For Liquid Level widgets, there is Level filter parameters group instead of Position filter parameters
group.

4.5 Notice List
The Notice List pane combines notices (errors, warnings, tasks, and notes) from many places in the
configuration into a centralized list. You can double-click a notice location to show a parameter causing the
error or warning.
For more information about the Notice List, refer to the Device Configurator user guide.

4.6 Tabs
The CAPSENSE™ Tuner consists of the following tabs:
• Widget View tab – Displays the widgets, their touch status, and the touch signal bar graph.
• Graph View tab – Displays the sensor data charts.
• SNR Measurement tab – Provides the SNR measurement functionality.
• Liquid Level Measurement tab – Provides the liquid level measuring functionality.
• Touchpad View tab – Displays the touchpad heatmap.
• Gesture View tab – Displays the Gesture operation.
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5 Tuner communication setup
The "Tuner Communication Setup" dialog is used to establish communication between the Tuner and target
device. The Tuner supports I2C, UART, and RTT communication interfaces.
Select Tools > Tuner Communication Setup… on the menu to open the dialog or click the Tuner
Communication Setup button. The dialog opens automatically after clicking the Connect button if no device
was previously selected.
Select the device and communication interface by checking the item with the interface name. Change the
interface configuration parameters to match the configuration of the communication peripheral in the
application.

Note: The parameters in the "Tuner Communication Setup" dialog must be identical to the parameters of
the EZI2C or UART driver in the application.

5.1 I2C

To establish the I2C communication between the Tuner and target device, configure the Tuner communication
parameters to match the parameters of the device EzI2C settings.
• The I2C communication can work in the two Read modes (see Main toolbar).

5.2 UART

To establish the UART communication between the Tuner and target device, configure the Tuner
communication parameters to match the parameters of the device UART settings.
Depending on the application capabilities, the UART communication may work in two modes: Read/Write and
Read Only (see Status bar).

Note: Recommended – enable the UART Flow control on the target device for bitrates equal or higher than
1000000.
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5.3 RTT
The RTT is an interface specified by SEGGER based on basic memory reads and writes to transfer data
bidirectionally between the target and host. Before configuring the RTT setup dialog, it is recommended to
familiarize yourself with the RTT protocol fundamentals at https://wiki.segger.com/RTT.
The data transfer between the host and target devices is organized through channels. The Tuner communicates
to the server (OpenOCD) via the TCP/IP protocol. The server in turn uses the SWD interface to communicate
with the device.
RTT communication advantages:
• SWD pins are used instead of reserving EZI2C or UART pins.
• The communication speed is the highest among all options.
To establish the RTT communication between the Tuner and target device, start either the local RTT server or
connect to an existing one. For details on the application layer, refer to Setting up RTT communication in the
application.

5.3.1 Start RTT server locally

To start the RTT server in your local environment, select Start RTT server locally and modify the following
fields:
• Executable – The * .elf file generated by the firmware build. In most cases, it will be prefilled automatically

based on the ModusToolbox™ project.
• TCP ports range – Used for the RTT communication. Each port is mapped to a channel. Set up at least two

channels because Channel 0 has limitations.
• Tuner TCP port – The TCP port used by the Tuner.
• OpenOCD .cfg file – Provides the* .cfg file name for OpenOCD. In most cases, it will be detected

automatically based on the application target device and will not display on the GUI. If becomes visible
when the * .cfg file name value cannot be detected by the Tuner automatically and must be selected
manually. The * .cfg file name can be found in the .launch file of your project.

To manage the RTT server, the Tuner uses the * .rtt.tcl file located with the Tuner executable (or capsense-
tuner.app/Contents/Resources/ on macOS). It starts an OpenOCD session, which lasts while the Tuner is
connected to the device.

Note: Only one instance of OpenOCD can run at a time. If you want to debug the application simultaneously,
refer to RTT communication with simultaneous debug.
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5.3.2 Connect to an existing RTT server

To connect to an existing RTT server, deselect Start RTT server locally and modify the following fields.
• Hostname or IP – Specifies the host or IP address of the running RTT server.
• Tuner TCP port – The TCP port used by the Tuner.

5.3.3 Setting up RTT communication in the application
To enable the RTT communication, include the SEGGER RTT library in the application. It is a part of the J-Link
Software and Documentation Pack, which is available for download on the SEGGER official website. The RTT
library is located inside the "Samples" folder. Place it in the project root folder. Refer to the RTT API
documentation to learn how to use it.
Add sample code to the main.c file:
• Include a header

#include "SEGGER_RTT/RTT/SEGGER_RTT.h"

• Initialize RTT

SEGGER_RTT_Init();
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• Configure the up and down buffers.
- Set the size of the up buffer to at least sizeof(cy_capsense_tuner) + 5 + 1 (5 bytes for the packet header

and trailer, 1 byte for internal RTT purposes).
- Set the size of the down buffer to at least 32 bytes.

SEGGER_RTT_ConfigUpBuffer(RTT_TUNER_CHANNEL, "tuner", &tunerUpBuf, sizeof(tunerUpBuf), 
SEGGER_RTT_MODE_NO_BLOCK_SKIP); 
SEGGER_RTT_ConfigDownBuffer(RTT_TUNER_CHANNEL, "tuner", &tunerDownBuf, 
sizeof(tunerDownBuf), 
SEGGER_RTT_MODE_BLOCK_IF_FIFO_FULL);

• Implement the send and receive functions. Assign them to the callbacks.

Static void rtt_tuner_send(void * context);
static void rtt_tuner_receive(uint8_t ** packet, uint8_t ** tunerPacket, void * context);
...
cy_capsense_context.ptrInternalContext->ptrTunerSendCallback    = rtt_tuner_send;
cy_capsense_context.ptrInternalContext->ptrTunerReceiveCallback = rtt_tuner_receive;
...
cy_capsense_context.ptrInternalContext->ptrTunerSendCallback    = rtt_tuner_send;
cy_capsense_context.ptrInternalContext->ptrTunerReceiveCallback = rtt_tuner_receive;

...

void rtt_tuner_send(void * context)
{
    (void)context;
    /* Packet size including 2-byte header and 3-byte trailer */
    uint16_t elemCount = sizeof(cy_capsense_tuner) + 5;

    /* Lock RTT */
    SEGGER_RTT_LOCK();
    SEGGER_RTT_BUFFER_UP *buffer = _SEGGER_RTT.aUp + RTT_TUNER_CHANNEL;
    /* Copy CAPSENSE tuner structure data to the buffer */
    ...
    /* Manually update the pointers */
    buffer->RdOff = 0;
    buffer->WrOff = elemCount;

    /* Unlock RTT */
    SEGGER_RTT_UNLOCK();
}

...

void rtt_tuner_receive(uint8_t ** packet, uint8_t ** tunerPacket, void * context)
{
    while(0 != SEGGER_RTT_HasData(RTT_TUNER_CHANNEL))
    {
        uint8_t byte;
        SEGGER_RTT_Read(RTT_TUNER_CHANNEL, &byte, 1);
        ...
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    }
}

The Tuner is expected to receive packets in the following format:

OD 0A <cy_capsense_tuner> 00 FF FF

5.3.4 OpenOCD Log pane
The Tuner offers a special OpenOCD Log view to observe OpenOCD communication logs.

5.3.5 RTT communication with simultaneous debug
The RTT interface allows communication with the CAPSENSE™ Tuner and debugging simultaneously over the
same pair of SWD pins. The RTT communication utilizes OpenOCD. To debug simultaneously, establish a
connection with the Tuner and then attach the debugger to the already running OpenOCD session. For details,
refer to the debug section of your IDE user guide.

5.4 Communication and Low power mode
The Tuner requires a working communication channel (I2C, UART, RTT). While the device is operating in Low
power mode, it cannot communicate with the Tuner. In order to have a stable communication, Synchronization
mode was introduced between the Tuner and the device. In this mode, the Tuner controls the device,
particularly the moment of starting a next scan. If this process is interrupted, communication may be lost. To
avoid this, follow the recommendations:
These are the limitations necessary for maintaining the successful connection of the Tuner with a device:
• The PSOC™ side firmware ensures that after the device exits Deep Sleep mode, the device stays in the active

state with the working communication channel, which enables the Tuner to receive at least one packet
with valid data.

• The device sleeps less than the Tuner-defined timeout (see the LP command timeout in the Tuner
Configuration Options dialog, Advanced tab).

• Implement the Deep Sleep callback, which waits for the completion of an EzI2C/UART transaction before
the transition to Deep Sleep.

Also recommended:
• Add Cy_SysLib_Delay 100-500 ms after the CAPSENSE™ initialization completes before the transition to Deep

Sleep to give the Tuner time to exchange packets with the device.
The Tuner has the following timeouts by default:
• Connect timeout: 3 sec
• Read/write timeout: 250 sec.
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5.5 Status bar
The Status bar at the bottom of the GUI displays information related to the communication state between the
Tuner and the device. Some sections differ depending on the communication type as follows:

I2C interface

UART interface

RTT interface

Fields

• Scan rate – A number of scans performed by the device per second.
• Packet rate – A number of read samples performed by the Tuner per second. The count depends on

multiple factors: the selected communication channel, communication speed, and amount of time for a
single scan. The Packet rate can be lower or equal to the Scan rate.

• Bridge status – Either Connected, when the communication channel is active, or Disconnected otherwise.
• Slave address (I2C) – The address of the I2C slave configured for the current communication channel.
• I2C clock (I2C) – The data rate used by the I2C communication channel.
• Mode – The data transmission mode:

- Read/Write – Provides data transmission in two reverse directions: target device → Tuner→ target
device. You can change the parameters of the widgets/sensors at run-time. To upload the modified
configuration, click the Apply to Device button.

- Read only – Provides data transmission in one direction: target device → Tuner. You cannot upload
the parameters of the widgets/sensors to the device at run-time. But for the I2C protocol you can still
upload parameters that do not require re-initialization.

• Baud rate (UART) – The data rate, at which CAPSENSE™ operates with the current settings.
• Tuner TCP port (RTT) – Used by the Tuner to connect to the RTT server.
• RTT Server (RTT) – Indicates if the RTT server is started locally or on a specific host.
• Supply voltage – The supply voltage.
• Logging – Either ON (when the data logging to a file in progress) or OFF.
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6 Widget View tab
The Widget View tab provides a visual representation of all widgets selected in the Widget Explorer panee. If a
widget consists of more than one sensor, individual selected sensors are highlighted in the Widget Explorer
pane and Widget/Sensor Parameters pane.

The Widget and/or sensors are highlighted when the device reports their touch status as active.
Some additional features are available depending on the widget type.

6.1 Touch Signal Graph
The Widget View tab also displays the Touch Signal Graph. This graph contains a touch signal level for each
sensor selected in the Widget Explorer pane.
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7 Graph View tab
The Graph View displays graphs for the sensors selected in the Widget Explorer pane.

The following graphs are available:
• Sensor Data – Displays RawCount and Baseline. Click a corresponding check box to see them. Under

Multi-frequency mode, RawCount and Baseline are available for three channels: 0, 1, 2.
• Sensor DiffCount – Displays signal differences.
• Status – Displays a sensor status (Touch/No Touch).
• Position – Displays touch positions for the Linear Slider, Radial Slider, and Touchpad widgets.

Note: For 5th generation CAPSENSE™ configuration with enabled Multi-frequency mode, there is a Median
graph on the Sensor Signal graph for each sensor. For Multi-frequency mode, three varieties are
scanned for each sensor at three different frequencies and three different raw-counts are obtained
for the same sensor. The sensor state is estimated by one median value calculated from the obtained
three raw-counts. A Median graph shows a set of F0 values received from a kit. The graph becomes
visible if at least one of the graphs F0, F1, F2 is visible. Then, the Tuner calculates the actual value of
F0 from received data.

7.1 Graph View tab toolbar
Go to Tabs toolbars table to see the descriptions of the Graph View tab toolbar.
• Chart settings – Opens the menu for editing the chart line series parameters.
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- Crosshairs – Consists of two lines parallel to the coordinate axes. The vertical component always
shows the X coordinate of the mouse cursor and moves with the mouse pointer synchronously on
all four charts: Sensor Data, Sensor Signal, Status, and Position regardless of their scale and shift.
The horizontal component is visible only on the chart (active chart) over which the mouse cursor is
hovering. The Crosshairs context menu has many more options:

• Vertical marker lines – When you left-click, the Tuner adds a Vertical marker line with a value equal to the
X coordinate of the mouse cursor synchronously on all four charts – Sensor Data, Sensor Signal, Status, and
Position regardless of their scale and shift. Press the [Esc] key to erase all previously drawn Vertical marker
lines. You can change the characteristics of Vertical marker lines or disable them in the submenu Chart
settings > Vertical marker lines.

ModusToolbox™ CAPSENSE™ Tuner user guide

7  Graph View tab

user guide 24 002-24353 Rev. *Q
2025-03-28



• Stopping bars – When performing Stop communication, the Tuner adds a rectangular mark after the
current endpoint synchronously on all four charts. After a new start of communication, new chart points
will be added after the last Stopping bar. You can change the Stopping bars characteristics or disable them
in the Chart settings > Stopping bars submenu.

7.2 Graph functionality
The Graph functionality includes:
• Highlighting – If you click a sensor line series on the graph, the corresponding sensor series highlights on

the Legend pane. Likewise, if you click a sensor series on the Legend pane, it highlights a sensor line series
on the graph. To highlight lines for all graphs at the same time, press and hold the [Ctrl] key. To select
multiple sensors in the other View tabs, press and hold the [Alt] key.

• Pan and – Allow you to examine graphs in more detail. Use a mouse drag for pan. Press and hold the
[Shift] key to select the area you need to examine. Press and hold the [Ctrl] key to examine all the graphs
simultaneously.

• Use the mouse wheel for Zoom. The [Ctrl] key + mouse wheel zooms all graphs simultaneously. Press the
[Esc] key to undo zoom and pan for all graphs.

• Context menu – Provides the options to change the appearance of graphs. To display the menu, right-click
one of the charts: Sensor Data, Sensor Signal, Status, Position, or the chart's legend. The context menu
options are the same as for Graph View tab toolbar> Chart settings: increase/decrease the line width and
zoom.
The context menu for selected graphs also contains:
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- Color – To change a sensor series color on the Legend pane, either double-click or right-click the
sensor and select the Color option from the displayed menu. The "Please choose a color for …" dialog
displays. You can change the color for the graph lines of the same sensor (widget) on all the charts of
the Graph View and on the Touch Signal Graph of the Widget View simultaneously.

Select a color and click OK. To select a color for all the graphs at the same time, press and hold the
[Ctrl] key while clicking.
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8 SNR Measurement tab
The SNR Measurement tab allows measuring an SNR for individual sensors. It provides the user interface to
acquire noise and signal separately and then calculates an SNR based on the captured data. The obtained value
is then validated by a comparison with the required minimum (5 by default, can be configured in the Options
dialog).

8.1 SNR Measurement procedure
1. Click Connect to the device and then Start communication on the toolbar.
2. Switch to the SNR Measurement tab.
3. Select the sensor by clicking it on the Widget Explorer pane and observe the Select sensor block

become green.
4. Ensure no touch is present on the selected sensor.
5. Click Acquire Noise and wait for the required count of samples to be collected. Observe the Raw counts

for Noise block become green after the action completes.
6. Observe the Noise parameter be updated with the calculated noise average value.
7. Touch the selected sensor to produce a signal on it.
8. Click Acquire Signal and wait for the required count of samples to be collected. Observe the Raw counts

for Signal block become green after the action completes.
9. Observe the Signal parameter be updated with the calculated signal average value.
10. Observe the SNR parameter be updated with the SNR. The Validate SNR block becomes green if the

result is PASS, if FAIL – red.
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8.2 SNR measurement pane
The SNR Measurement procedure pane indicates the SNR measurement stages. The status is defined by the
background color: green means the stage is successfully completed.

The progress bar provides graphical guidance to the user to complete the SNR measurement. The bar displays
the progress and user-addressed relevant messages.
The measured noise, signal, and SNR values are displayed below the progress bar. The SNR value is calculated
as Signal divided by Noise rounded up to 2 decimal points. The result has the following meaning:
• PASS – The SNR is above the required limit (green).
• FAIL – The SNR is below the required limit (red).
• N/A – The SNR cannot be calculated because noise/signal samples are not collected yet (grayed out).

8.3 Graph chart
The Graph chart displays the measured sensor noise and signal. Noise and signal spikes displayed on the chart
are the points ignored during the SNR calculation.

Click the Legend button to make it visible or invisible.
• Position of Legend (six directions)
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• Context menu – Provides the options to change the appearance of graphs. To display the context menu,
right-click any chart.

For a description of Legend, Spike, Clear, and Save image, go to the Tabs toolbars table.

8.4 SNR options
SNR parameters can be modified in the options dialog. See Tuner Configuration options for descriptions of
other tabs on this dialog.

Fields:
• Noise sample count – The count of samples to acquire during the noise measurement operation.
• Signal sample count – The count of samples to acquire during the signal measurement operation.
• SNR pass value – The minimal acceptable value of the SNR.
• Ignore spike limit – Ignores a specified number of the highest and the lowest spikes at noise / signal

calculation. That is, if you specify number 3, then three upper and three lower raw counts are ignored
separately for the noise calculation and for the signal calculation.
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• Noise calculation method – Allows selecting the method to calculate the noise average. The following
methods are available for selection:
- Peak-to-peak (by default) – Calculates noise as a difference between the maximum and minimum

value collected during the noise measurement.
- RMS – Calculates noise as a root mean-square of all samples collected during the noise measurement.

• Progress bar text mode – This label is shown with the progress bar:
- Hide (by default) – No label.
- Percent – The number of samples in percent acquired during the signal measurement operation.
- Value – The number of samples acquired during the signal measurement operation.

Note: This option is not available on Mac OS.

• Signal graph below noise – Displays the signal series below the noise threshold on the graph.
• Show spike points – Highlights the spike points on the graph.
• Show legend – Shows the graph legend. The Legend has the context menu to change its position.

Right-click the Legend to see the menu.
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9 Liquid Level Measurement tab
The Liquid Level Measurement tab allows measuring high-resolution liquid levels based on the captured data.
The tab provides the user interface to provide the minimum step resolution and the total depth of the tank to
measure. The Tuner calculates these parameters. Start with selecting a Liquid Level widget on Widget Explorer
pane.

The Tuner can perform the Liquid Level measuring for:
• Liquid Level
• Liquid Level with foam rejection
The procedure is described in the Measure liquid level and Measure liquid level with foam rejection.
Parameters
• Tank height – The height of the tank. Range: 35-1000.
• Resolution (step size) – The resolution of measurement. Range: 0.1-1000.
• Number of average samples per step – The number of samples per measurement level. Range: 1-1000.
• Disable CDAC auto-calibration – Disables the CAPDAC auto-calibration on power-up.

Note: Any changes in the configuration require re-programming the device before calibration.

9.1 Liquid Level Measurement pane
The Liquid Level Measurement pane is the graphical illustration of the measurement process. The current
level (tank) is indicated by the triangle.

The Liquid Level Measurement pane contains buttons to execute the measuring process and a visual element.
• Previous level – Allows switching to the previous level but does not log data automatically. Disabled when

there is no previous level.
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• Log data – Reads data from the device to the current level. After data is successfully read, the level
automatically moves to the next one. The number of the level under the Log data button corresponds to
the liquid level of the tank.

• Next level – Allows switching to the next level.
• Finish calibration – Click this button to generate coefficients.
• Use the context menu:

• to set different colors for logged/not logged levels and background
• to enable gradient
To see the height and data values of a level, hover over it.

9.2 Measure liquid level
Instructions
1. Connect with unchecked Disable CDAC auto-calibration.
2. Check Disable CDAC auto-calibration, save the configuration/data, and program the device.
3. Log data for each liquid level starting with Empty tank. The Tuner saves data to the * .csv file.
4. Click Save logged data.
5. Click Finish calibration.

9.3 Measure liquid level with foam rejection
Instructions
1. Connect with unchecked Disable CDAC auto-calibration.
2. Check Disable CDAC auto-calibration, save the configuration/data, and program the device.
3. Log data for Empty and Half-Empty tank level.
4. Log data for each liquid level starting with the Empty tank. The Tuner saves data to the * .csv file.
5. Click Save logged data.
6. Click Finish calibration.

9.4 Graph chart (LL)
The Graph chart is empty until you start logging data and then the Liquid Level sensor data and Foam Rejection
sensor data charts get populated with Liquid Level and RawCount parameters data.
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9.5 Save/Load logged data
Allows saving and loading the gathered raw counts during the measuring process to/from the design.lls.csv file
residing along to the configuration file.
• Export to other file... – This option allows you to save gathered raw counts into a non-default user

specified file
• Import from other file... – This option allows you to load raw counts data from a non-default user

specified file.
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10 Touchpad View tab
This tab visually represents signals and positions of a selected touchpad widget in the heatmap form. Only one
CSD and one CSX touchpad can be displayed at a time.
Note: The Touchpad View tab is disabled when there are no touchpad widgets in the configuration.

10.1 Widget selection
Consists of the configuration options for mapping physical touchpad orientation to the identical representation
in the heatmap:
• CSD combo box – Selects any CSD touchpad to display in the heatmap.
• CSX combo box – Selects any CSX touchpad to display in the heatmap.
• Flip X-axis – Flips the displayed X-axis to match the orientation of a physical touchpad.
• Flip Y-axis – Flips the displayed Y-axis to match the orientation of a physical touchpad.
• Swap XY-axes – Swaps the X- and Y-axes for the touchpad.

10.2 Display settings
Manages heatmap data to display. These options are applicable for the CSX touchpad only.
• Display mode – The drop-down menu with 3 options for the display format:

- Touch reporting – Shows current detected touches only.
- Line drawing – Joins the previous and current touches in a continuous line.
- Touch Traces – Plots all the reported touches as dots.

• Data type – The drop-down menu to select the signal type to display: Diff count, RawCount, and Baseline.
Under Multi-frequency mode, RawCount and Baseline are available for three channels: 0, 1, 2.
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• Value type – The drop-down menu to select the type of a value to display:
- Current – The last received value.
- Max hold – The maximum value out of latest “Number of samples” received.
- Min hold – The minimum value out of latest “Number of samples” received.
- Max-Min – The difference between maximum and minimum values.
- Average – The average value of latest “Number of samples” received.

• Number of samples – Defines a length of history of data for the Line Drawing, Touch Traces, Max hold, Min
hold, Max-Min, and Average options.

• Display touch position – Selects the touchpad from which data displays in the heatmap. The options:
- Display only CSX
- Display only CSD
- Display both.

10.3 Show signal
Enables displaying data for each sensor if checked, otherwise displays only touches. This option is applicable
for the CSX touchpad only.
• Color range – Defines the range of sensor signals within which the color gradient is applied. If the sensor

signal is outside the range, the sensor color is either minimum or maximum out of the available color
palette.

10.4 Touch report
• CSD touches table – Displays the current X and Y touch position (Z value is always 0) of the detected

touches on the CSD touchpad. If the CSD touchpad is neither configured nor a touch is detected, the touch
table is empty. When the two-finger detection is enabled for the CSD touchpad, two touch positions are
reported.

• CSX touches table – Displays the current X and Y touch position and Z values (amplitude) of the detected
touches on the CSX touchpad. If the CSX touchpad is neither configured nor a touch is detected, the touch
table is empty. The middleware supports simultaneous detection up to three touches for the CSX touchpad
touch, so the touch table displays all the detected touches.

10.5 Hot keys
Keyboard
shortcuts

Commands Same as

Alt + N Select a color for the minimum value. Click the Min color… button.

Alt + X Select a color for the maximum value. Click the Max color… button.

Alt + B Select a color for the text.  

Ctrl + K Set the next scatter shape for the CSD mark.  

Ctrl + L Set the previous scatter shape for the CSD mark.  

Alt + + Increase the line width/mark radius.  

Alt + - Decrease the line width/mark radius.  
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Keyboard
shortcuts

Commands Same as

Alt + 0
…
Alt + 7

Select a color for the CSX position with ID=0…7. Double-click the ID column cells of the CSX
touches table.

Alt + 8 Select a color for the CSD touch position. Double-click a cell in the Touch # column of
the CSD touches table.

Ctrl + C Clear the heatmap. Click the Clear button on the local toolbar.

Ctrl + + Zoom in the heatmap. Click the Zoom in button on the local
toolbar.

Ctrl + - Zoom out the heatmap. Click the Zoom out button on the local
toolbar.

Esc Cancel zoom.  
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11 Gesture View tab
This tab visually represents evaluation and tuning of gestures (from one widget at a time).
Note: The Gesture View tab is disabled when there are no gesture widgets in the configuration.

Note: Synchronized communication mode or UART communication is recommended for Gesture validation,
to make sure no gesture event such as a touchdown or lift-off is missed during communication.

11.1 Widget selection
Allows selecting a widget and controls that the Tuner display matches the orientation physical widget on
hardware.
• Combo box – Selects the widget with Gesture enabled to display the Gesture from it on this pane.
• Flip X-axis – Flips the direction of the X-axis to match the orientation of a physical widget.
• Flip Y-axis – Flips the direction of the Y-axis to match the orientation of a physical widget.
• Swap XY-axes – Swaps the X- and Y-axes to match the orientation of a physical widget.

11.2 Image pane
• An image reacts to the detected gestures (scroll and zoom) and moves around the pane. You can change

the image by clicking the Open image tool button.

11.3 Gesture Monitor
Provides visual indication for a detected gesture. It shows gestures for one widget at a time. The widget can be
selected in the Gesture View tab.
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If the Delay check box is enabled, a gesture picture is displayed only for the specified time-interval. If disabled,
the last reported gesture picture is displayed until a new gesture is reported.

11.4 Gesture Event history
Logs the detected gestures information.
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12 Tuner Configuration options
The Tuner application allows setting different configuration options with the options dialog. The settings are
divided into groups.

12.1 Display options

12.1.1 Theme
Defines the visual style of widgets.

12.2 SNR options

See the SNR options section for a description of this tab.
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12.3 Logging options

Fields:
• Log directory – Browse for the application directory where the CAPSENSE™ Tuner log files are located.
• Log file prefix – The prefix name is the user's input for the log file name. For example, <prefix_name>-

<time_stamp>.csv.
• Number of samples – Defines a log session duration in samples. The header is repeated after a number of

samples.
• Data configuration check box table – Selects data to collect into a log file.

12.4 Advanced options

Fields:
• Device reset on connection – If this option is enabled, the target reset is performed on Connect and

Disconnect for 5th generation LP CAPSENSE™ devices, which helps to establish connection even if the
device was in Deep Sleep mode.

• LP command timeout (ms) – Defines the timeout for Read and Write commands for 5th generation LP
CAPSENSE™ devices. During this time, the Tuner will repeatedly try to read/write data until the device
wakes up from Deep Sleep and the operation succeeds. Default: 250000 ms.

• I2C response delay (ms) – Configures a delay after the ONE_SCAN command is sent and before the device
response is read via the I2C communication protocol in Synchronous mode. The value indicates that the
host will not make read requests until the specified time has elapsed. Recommended for long scans to
prevent possible noise.
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13 Troubleshooting
Problem Workaround

On common Linux distributions, the
serial UART ports (usually /dev/ttySx
or /dev/ttyUSBx devices) belongs to the
root user and to the dialout group.
Standard users are not allowed to
access these devices.

An easy way to allow the current user access to the Linux machine's
serial ports is by adding the user to the dialout group. This can be
done using the following command:

$sudo usermod -a -G dialout $USER

Note: Note: For this command to take effect, you must log out
and then log back in.

On macOS, the CAPSENSE™ Tuner can't
be launched from the Launchpad.

Launch the Tuner from within the Device Configurator or use the
command line option.

On common Linux distributions, the
Tuner forbids communication interface
selection after re-plugging KitProg
during communication.

Refer to the “Installation Procedure on Ubuntu Linux (x64)” section
in the Cypress Programmer 2.1 CLI User Guide.

KitProg3 UART is accessible but not able
to read data on Linux kernel 4.15 and
above or Mac OS X 10.13 and above.

Use third-party UART to USB bridge.
Update the KitProg3 firmware to version 1.11.243 or above.

Cannot establish communication with a
device that operates in Low power
mode.

Refer to the Communication and Low power mode section.

Unable to connect to the device via the
RTT communication protocol. The
OpenOCD log displays an error “Could
not find symbol '_SEGGER_RTT' in
executable”.

RTT support is not enabled in the application. Refer to the Setting up
RTT communication in the application section.

Note: The Tuner provides information about the root cause of connection to KitProg issue in an operation
log. The operation log location can be found in the About CAPSENSE™ Tuner box.
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14 Version changes
This section lists and describes the changes for each version of this tool.

Version Change descriptions

1.0 New tool.

1.1 Added UART interface.

Added possibility to save different views as images.

Added zoom and pan functionality for graphs.

Fixed minor issues.

2.0 Added "IDAC gain index" parameter.
Changed the data storage location from a header (.h) file to an XML-based *.cycapsense file.
For backward compatibility, the configurator is still able to load the header (.h) file that
contains the legacy format configuration. But, if the legacy header (.h) with the configuration
is passed via a command-line parameter, a message appears saying that the .h file is not
supported.
Added the Import and Export options to the File menu that enable importing and exporting
the configuration file from and into the external file.
Added the Reset View command to the View menu that resets the view to the default.
Added Multi-frequency support that enables selecting RawCount and Baseline.
Added the UART option description in Status Bar.
Changed generation of the middleware initialization structure according to the changes in
CapSense v2.0 middleware (related to added fields for flash memory optimization, fixed
defect with RawCount filters config, IDAC gain index, etc.).
Added support for selecting multiple sensors in some view and reflecting the selection in
other views.
Added handling of invalid command line arguments.
Added highlighting of modified properties in the property grid with bold.
Added a warning if opening a broken configuration file.
Fixed memory leaks.
Fixed Graph View issues under high load of application.

3.0 Added the Undo / Redo feature.

Changed the list of UART baud-rate possible values to match the values supported by KitProg.
The highest rate is 3000000.

3.10 Updated versioning to support patches.

Added a popup notification when the Apply to device command completes.

Increased the communication speed between the device and Tuner when using the I2C
interface.

Improved the tool performance for loading large configurations.

Fixed the issue with applying changes to the device when using the UART communication
interface: now, many changes (>16) are applied correctly.

3.11 Updated versioning to support the updated backend, for detail, see Device Configurator user
guide.
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Version Change descriptions

3.15 Removed from the GUI the possibility to change several UART settings (data bits, stop bits,
parity) in order to match KitProg-supported values. The values used: data bits = 8, stop bits =
1, parity = none.

Optimized the I2C interface communication to increase the speed.

4.0 Added support for the PSOC 4100S Max family.

Added support for the CAPSENSE™ Middleware Library 3.0.

Added a CSX touchpad sensor status display on the Graph view.

Logging data from the device: removed the header duplication from the bottom of the pages
of the file.

Changed the operation log file location. The new location can be found in the About
CapSense Tuner dialog.

5.0 Added support for the 5th generation LP CAPSENSETM devices.

Added support for the CAPSENSE™ Middleware Library 4.0.

Changed the device library file from xml to props.json.

Added the possibility to use the Tuner with USB UART bridges from other vendors.

Added a set of auxiliary chart commands on the Graph and SNR views.

Added a panel to display widget and sensor parameters description.

6.0 Added a ‘Scan rate’ field in the status bar. The ‘Refresh rate’ field renamed to ‘Packet rate’.

Added support of UART communication interface for the 5th generation LP devices.

Fixed minor display issues.

Updated information logged in the .log file.

Changed the structure of the packets sent from the device to the Tuner for the 5th generation
LP devices.

6.10 Added support for RTT communication interface.

Fixed the issue with the displaying button gestures.

Improved I2C communication speed.

Added the I2C response delay parameter on the Options tab.

6.20 Improved the auto-calibration feature for the MSCLP platform.

Added support of CapDAC Auto-Dithering.

Improvement – only relevant gesture parameters display.

Added the ability to switch to UART async mode for LP devices.

Added the editable prefix to the log file.

Updated OpenOCD logging.

Added displayed Sensor/Electrode capacitance.

6.30 Minor back-end changes.

6.40 Minor back-end changes.

7.10 Added support for ISX sensing method.
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Version Change descriptions

Added support for Liquid Level widget.

8.00
Added support of the PSOC™ 4100T Plus device family.

Added scaling CDAC parameters for widgets that use the CSD sensing method.
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